EndNote How-To Book

EndNote Training
Introduction

The first thing you need to know is this is not a manual. It will not tell you which operating system any given version of EndNote is compatible with or how much RAM you need to run EndNote. It will not try to cover each finicky detail of what EndNote can do.

So, what is it?

This is an ebook of instructions on how to accomplish specific tasks in EndNote, such as importing references from a specific online database. The author will try to keep the screenshots and instructions as current as possible, which means there may be frequent new editions of this book. The goal will always be the same, though—to teach you how to make EndNote do the things you want it to do.

Please note that menu colors may be different than those shown depending on your operating system and system color preferences.

Thank you for using EndNote!
# Table of Contents

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>3</td>
</tr>
<tr>
<td>Installing EndNote</td>
<td>1</td>
</tr>
<tr>
<td>Using Direct Export to Import References from Online Databases</td>
<td>13</td>
</tr>
<tr>
<td>2.1 Direct Export from Web of Science</td>
<td>13</td>
</tr>
<tr>
<td>2.2 Direct Export from PubMed</td>
<td>18</td>
</tr>
<tr>
<td>2.3 Browser Actions with DirectExport</td>
<td>21</td>
</tr>
<tr>
<td>2.4 EndNote Online Plug-In for Direct Export</td>
<td>27</td>
</tr>
<tr>
<td>Importing PDF Files and PDF Handling</td>
<td>27</td>
</tr>
<tr>
<td>3.1 Importing PDF Files</td>
<td>27</td>
</tr>
<tr>
<td>3.2 Setting PDF Handling</td>
<td>30</td>
</tr>
<tr>
<td>Importing TextFiles</td>
<td>32</td>
</tr>
<tr>
<td>4.1 Web of Science</td>
<td>32</td>
</tr>
<tr>
<td>4.2 PubMed</td>
<td>38</td>
</tr>
<tr>
<td>Cite While You Write</td>
<td>45</td>
</tr>
<tr>
<td>6.1 Cite While You Write in Microsoft Word on Windows</td>
<td>45</td>
</tr>
<tr>
<td>6.2 Cite While You Write in Microsoft Word 2016 on Macintosh</td>
<td>50</td>
</tr>
</tbody>
</table>
1 Installing EndNote

This chapter will have step-by-step instructions and screenshots.

EndNote can be installed on multiple computers just as a single user would install it, entering the product key for every installation.

1.1.1 A Custom Installation for a Site License Copy of EndNote on Windows

A typical installation of EndNote installs less than 500 styles, 500 filters, and 500 connection files to EndNote, even though there are thousands of styles, as well as many more filters and connection files. A custom installation allows the user to add extra sets of styles, filters, and connection files to EndNote. For example, a user could add all the humanities styles available to the typical set.

If you have a previous version of EndNote installed, you should uninstall it using Control Panel before installing the new version.

Your school, company, or agency will need to provide you with two files to install the program, an ENX9Inst.msi installer and a license.dat file. These two files must be together in the same folder for the installation to run without asking for a product key. If you are given a zipped file containing these two files, as in the example file shown below, you will need to extract them from the zipped file before running the installer. Right-click on the file, then select the Extract All option as shown below.

- Use the Browse button to select the folder the files will be placed in after extraction, then click the Extract button.
- The files will be extracted to the selected folder. Keep the two files together and double-click on the *ENX9Inst.msi* file to start the installation.

![Image of file folder with EXN9Inst.msi highlighted]

- In the window below, click the *Next* button to continue.

![Image of EndNote X9 Setup window with Welcome to EndNote X9 message]

Thank you for choosing EndNote X9, the referencing software that lets you work smarter.

- **Smarter Teamwork**
  - Share selected groups of references, manage team access, and track activity and changes
  - Smarter Insights - now powered by Web of Science
    - Track the impact of references with Citation Report and find the best-fit journal for your papers with Manuscript Matcher

- **Smarter Workflow**
  - Automatically create, format, and update bibliographies, with the convenience of remote access online or on your iPad
  - Build your bibliography with the latest reference types, including blogs, multimedia, and social media
  - Ensure bibliographic accuracy with new refreshed styles to update references to key styles such as Chicago, ALA, MLA, and APA

![Image of Next button highlighted]

---

[Image of file folder with EXN9Inst.msi highlighted]

[Image of EndNote X9 Setup window with Welcome to EndNote X9 message]

---
• Click the Accept button to confirm that you have permission from your organization to install the EndNote software. If you do not have permission, you should not install the software.

• Next you will see the window below, where you can review the Read Me Information. Then click the Next button to continue.
• In the window below, read and accept the EndNote end user license agreement before you click Next to continue the installation.

• In the window below, decide if you will perform a typical installation or a custom installation. If you select a Typical installation, a limited set of popular styles, filters, and connection files will be installed. If you select a Custom installation, you can choose which additional sets of styles, filters, and connection files will be added to the typical set. The remaining windows will show the options for a Custom installation. Click Next to continue.
• By default, the program will be installed in the C:\Program Files (X86)\EndNote X9 folder, but you can change this if you need to. It is best to leave it with the default location unless it is necessary to put it in another folder for some reason, such as a lack of space on the C drive. Click the Next button to continue.

• In the window below—
  1. Click the plus sign (+) by an option to open it for editing.
  2. Click the drop-down list button for the sets of styles, filters, or connection files you want to add. For this example, the set of all Arts and Humanities styles is selected.
  3. Select the Will be installed on local hard drive option to add that set of files to the default set.
  4. Click the Next button after making all your selections.
• Note: In the window above you could also click the option (for example, *Additional Styles*), then select the option *Entire feature will be installed on local hard drive* to install all the files for that option. Please remember for Styles that would install over 6,000 styles.

• Click the *Next* button again in the window shown below.

![EndNote X9 Setup](image)

![Ready to Install the Application](image)

![EndNote X9 has been successfully installed.](image)

• If you see a window asking if you want to allow the EndNote application to make changes to your device, select *Yes*.

• Click the *Finish* button when you see the window below saying EndNote has been successfully installed. You are now ready to begin using EndNote.

**Important:** Save a copy of the installation files in a safe place in case you need to install EndNote again in the future.
1.1.2 Before Installing EndNoteX9 Uninstalling previous EndNote versions on Macintosh

Previous versions of EndNote should be uninstalled before installing the current version.

- Close all EndNote libraries, then select Customizer from the EndNote menu to begin.

- In the Customizer window shown below, unmark all boxes, then click the Uninstall button.

- There will be a warning that all external EndNote components will be uninstalled. Click Yes to continue uninstalling EndNote.
When the uninstall finishes you will see the window below. Click the Exit button, then drag the EndNote folder in Applications to the trash. If you have stored any personal libraries, styles, filters, or connection files in the EndNote folder, these should first be moved to the Documents folder. In general, it is best to keep these files in Documents.

You are now ready to begin the installation, described in section 1.2.4 below.

1.1.3 A Custom Installation for a Site License Copy of EndNote on Macintosh

A typical installation of EndNote installs less than 500 styles, 500 filters, and 500 connection files to EndNote, even though there are thousands of styles, as well as many more filters and connection files. A custom installation will allow the user to add extra sets of styles, filters, and connection files to EndNote. For example, a user could add all the humanities styles available to the typical set.

Note that your Security & Privacy settings must allow apps downloaded from the Mac App Store and identified developers to install EndNote.

If you have a previous version of EndNote installed, you should uninstall it before installing the new version. You can find instructions for uninstalling recent previous versions of EndNote in section 1.2.3.

You should receive a single file called EndNote X9 Site Installer.dmg from your site administrator like that shown below. Only a site installer can be used to install a permanent volume copy of EndNote without a product key. Double-click on the site installer to begin the installation.

In the window below, double-click the icon in the center to begin the installation.
• If you see a window like the one below, asking if you want to open the application, you will need to click the Open button to continue the installation.

• Click the Install button.

• Click the Next button in the Welcome to EndNote X9 window below.
Next you will see the window below, where you can review the Read Me information. Then click the Next button to continue.

Then the Done button in the window below to complete the installation.
• The first time you open EndNote, it will automatically create an EndNote library for you called “My EndNote Library” and place it in the Documents folder. It will also show the Welcome to EndNote guide below. When finished looking through the Welcome to EndNote guide you can close it using the Close button in the upper-left corner.

• To add styles, filters, and connection files, select Customizer from the EndNote menu.
• Click the small arrow by Connections, Import Filters, or Output Styles to select the type of files you want to add, then mark the box(es) for the set(s) you want, and click the Next button.

• You will also have the option to customize Cite While You Write if you have not used standard settings while installing Microsoft Word. Click Customize if you have a nonstandard Word installation, otherwise click Next.
When the Customizer finishes, click Done to finish. You are now ready to begin using EndNote.

**Important**: Save a copy of the installation file in a safe place in case you need to install EndNote again in the future.

### 2 Using Direct Export to Import References from Online Databases

#### 2.1 Direct Export from Web of Science

##### 2.1.1 Using the Marked List

Web of Science’s marked list provides a useful way to keep track of the references you want to keep when browsing a large set of search results. References can be added to the marked list as you browse through them, then exported from the marked list later.

- Perform your search of the Web of Science.
- Mark the references you want to add to the marked list, and click on the *Add to Marked List* button.

- When ready to export, go to the marked list by clicking the *Marked List* button.
- You will see a window like the one below with three “steps” for options.
• Select the records you want to import in Step 1 of the window, shown below (usually “All records in this list” if 500 or less).

![Step 1: Select records.](image)

• Select the fields you want to import in Step 2. The example below is from a search of the Web of Science Core Collection. If you are searching databases outside the core collection, there will be fewer fields available.

![Step 2: Select content.](image)

• Select **Save to EndNote desktop** from the drop-down **Save to** list in Step 3.

![Step 3: Select destination.](image)

At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For Web of Science it will end with a .ciw extension.

- Firefox on Windows
- Firefox on Macintosh
- Google Chrome on Windows
- Google Chrome on Macintosh
- Safari on Macintosh
  
  Safari does not support direct export.
2.1.2 Not Using the Marked List

- Perform your search on the Web of Science and select the references you want to import. Then select *Save to EndNote desktop* from the drop-down *Save to list*.

- You will see a window like the one below, if you have selected references by marking them, and will not need to do anything further to select references.

- If you have not selected references, you will see a window like this, and need to select either all the records on the page or a range of records.
• With either of the options above, you will now need to select the fields to export. Select the **Full Record** option to get the keywords and author’s address as well as the main bibliographic information. Note that the Full Record option will only be available when you are searching the Web of Science Core Collection. If searching outside the core collection, select **Author, Title, Source, Abstract**.

![Send to EndNote](image)

• Then click the **Send** button.

![Send to EndNote](image)

• At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For Web of Science it will end with a .ciw extension.
  
  o **Firefox on Windows**
  o **Firefox on Macintosh**
  o **Google Chrome on Windows**
  o **Google Chrome on Macintosh**
  o Safari on Macintosh
    Safari does not support direct export.
2.2 Direct Export from PubMed

2.2.1 Using the Clipboard

PubMed’s clipboard provides a useful way to keep track of the references you want to keep when browsing a large set of search results. References can be added to the clipboard as you browse through them, then exported from the clipboard later.

- Perform your search of PubMed and mark the references you would like to add to the Clipboard on each page, then click on the Send to link to send the selected references to the Clipboard.

- In the window shown below, select the Clipboard option, then click the Add to Clipboard button to add the selected references to the Clipboard. You can continue adding references to the Clipboard. Up to 500 references can be kept on the Clipboard for up to eight hours without activity.

- After adding items to the Clipboard, you will see a Clipboard link to the right of the Send to link, telling you how many items are in the Clipboard. When you have finished adding items to the Clipboard and are ready to send them to EndNote, click the Clipboard items link.
• In the Clipboard screen, click the Send to link, then select the Citation Manager option.

• Click the Create File button.

• At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For PubMed it will end with a .nbib extension.
  o Firefox on Windows
  o Firefox on Macintosh
  o Google Chrome on Windows
  o Google Chrome on Macintosh
  o Safari on Macintosh
    Safari does not support direct export.

2.2.2 Not Using the Clipboard

• Perform your search of PubMed. You can mark the references you would like to export on each page, if you wish. If you do not mark any references, all the references in the found set can be exported, in batches of up to 200 at a time. Click the Send to link to begin the export process.
• Then select Citation Manager.

• Select the number of references to export in the current batch, up to a maximum of 200 references.

• Keep track of the end number of the batch so you can repeat the export process for the next batch with the next consecutive record number. Then click the Create File button.

• At this point your browser will need to send the file to EndNote. Different browsers will react differently at this point. Click on your browser below for instructions on how to proceed for your browser the first time you attempt direct export in that browser. Note that the file type shown will be different for different databases. For PubMed it will end with a .nbib extension.
  o Firefox on Windows
  o Firefox on Macintosh
2.3 Browser Actions with Direct Export

2.3.1 Firefox on Windows

- Your EndNote library should be open before attempting to import references.
- Firefox will bring up a window similar to the one below the first time a new export file type attempts to download. On Windows, you can choose the ResearchSoft Direct Export Helper option or you can click the Other button to select another program to open the file with.

![Opening savedrecs.ciw](image)

- If you used the Other option, select the EndNote program to open the file in EndNote, then click the
OK button.

- When returned to the window below, you may select the option to *Do this automatically for files like this from now on*. Please note there are several different files types that work with direct export and you will need to go through this process for each of these file types (.ciw, .ris, .ovd, .enw, .nbib).

- Click the OK button to finish the import into EndNote.

### 2.3.2 Firefox on Macintosh

- Your EndNote library should be open before attempting to import references.
- There is a known issue with direct export and EndNote libraries saved as a package (.enlp) on the Mac for some versions of EndNote. EndNote may ask you to select a library even though your library is already open when importing. Clicking “Cancel” will still import the references. Libraries not saved as packages will not have this problem. If your library is saved as a package, you can select...
Save a Copy from the File menu to create a copy of the library in the standard format. Do not select the option to save the copy as a package when prompted for the copy’s name and location. After creating your copy, use the copy as your new EndNote library instead of the packaged file.

- Firefox will bring up a window like the one below the first time a new export file type attempts to download. To have the file open in EndNote so the references will be imported, click the Choose button to open the file with an application.

- This should bring up a window like the one below. Navigate to the Applications/EndNote folder and select the EndNote application. Then click on the Open button.

- When returned to the window below, you may select the option to Do this automatically for files like this from now on. Please note there are several different file types that work with direct export, and you will need to go through this process for each of these file types (.ciw, .ris, .ovd, .enw, .nbib).
• Click the **OK** button to finish the import into EndNote.

### 2.3.3 Google Chrome on Windows

• Upon selecting the option to export from the online database, you will see the items below in the bottom left corner of the Chrome window. Select the option to **Open**. (Note that you can also select the option to *Always open files of this type* if you are absolutely sure you always want Chrome to open those files in EndNote in the future.)

![Chrome window with export options]

• If you see the window below, click **More apps** to see a list of available applications. **Unmark the box to always use this app to open files of this type unless you are absolutely sure you always want this type of file to be opened by EndNote.**
You will then see a window similar to this, showing you a list of possible applications for opening the file. Select EndNote from the list. (Notes: This window may be different for different versions of Windows and Chrome. If you have installed the EndNote online plug-in for Internet Explorer and have previously set this file type to open, you may not see this window in Chrome. See section 2.4.1 for more information) Select the EndNote application. Once again, unmark the box to always use this app to open files of this type unless you are absolutely sure you always want this type of file to be
opened by EndNote. Then click the OK button.

2.3.4 Google Chrome on Macintosh

The author has found the commands below to work only when using OSX 10.10, Yosemite, or later with Google Chrome. This has not worked with earlier versions of OSX.

- Upon selecting the option to export from the online database, you will see the item below in the bottom left corner of the Chrome window. Click the ellipsis (...) to see a list of options.

- Select the option to Open. (Note that you can also select the option to Always open files of this type if you are absolutely sure you always want it to open those files in EndNote in the future.)

- If you see the window below, click Choose Application to see a list of available applications.

- Select the EndNote application in the Applications/EndNote folder, then click the Open button.
2.4 EndNote Online Plug-In for Direct Export

2.4.1 Google Chrome on Windows

- If you have installed the EndNote online plug-in for Internet Explorer and you have set Google Chrome to Open file types that are used with direct export instead of save them, you will see a window like the one below when you use direct export. Select EndNote if you want the search results sent to your EndNote desktop library. Select EndNote Online if you want the search results sent to your EndNote online library. See section 5.2 for instructions for installing the plug-in.

- If you have not installed the Internet Explorer plug-in, you will need to follow the directions in section 2.3.3.

3 Importing PDF Files and PDF Handling

3.1 Importing PDF Files

EndNote can import PDF files containing a Digital Object Identifier (DOI) in the metadata or the first two pages of the PDF. EndNote sends the DOI to PubMed and CrossRef, online databases capable of looking up reference data by DOI. The online databases send back the bibliographic information, EndNote imports it, then attaches the PDF to the record created. This means the PDF must have a DOI and EndNote must have access to the Internet during the import.

3.1.1 Importing a Folder of PDF Files on Windows
• Select 1) **Import** from the **File** menu, then 2) **Folder**.

![EndNote X9](image)

1) Click the **Choose** button, navigate to the folder you want to import, and double-click on it. It will appear in the **Import Folder** field. 2) If you wish to include subfolders within that folder, mark the box labeled **Include files in subfolders**. 3) If you want EndNote to create a separate group set for the main folder and groups within it for the subfolders, mark the box labeled **Create a Group Set for this import**. Leave the other settings at their defaults. (Note that EndNote will attempt to attach PDFs to matching records that already exist in the library instead of creating duplicate records.) 4) When all your options are set, click the **Import** button.

• The PDF files are imported. Below you see an example of the group set and groups that would be created for a folder called **Sample PDFs** that contained a subfolder called **Bats** and a subfolder called **Birds**.

![Sample PDFs](image)

3.1.2 Importing a Folder of PDF Files on Macintosh
• Select **Import** from the **File** menu.

![File menu with Import highlighted]

• Navigate to the location of the folder of PDFs you want to import. Select the folder, then click the **Options** button.

![Folder selection with Options button highlighted]

• In the Options, select **PDF File or Folder** if you do not want EndNote to create a group set and groups for the imported PDFs, or if you are only importing a single PDF. Select **PDF Folder as a Group Set** if you want EndNote to create a group set and groups for the imported PDFs. (Note: The rest of this example will show the group set option.)

![Options menu with PDF Folder as a Group Set highlighted]
• Leave the other options at the default settings and click the Import button. (Note that EndNote will attempt to attach PDFs to matching records that already exist in the library instead of creating duplicate records.)

![Import Options](image)

• EndNote will import the PDFs and create the group set and groups.

![Sample PDFs](image)

3.2 Setting PDF Handling

3.2.1 Windows

• Select Preferences from the Edit menu to open the EndNote preferences panel.

![Preferences](image)

• Click the PDF Handling option in the preferences panel to see the window below. Here you can set automatic renaming options for PDFs you import or set a “watched” auto-import folder. Any PDF added to the auto-import folder will be imported into the EndNote library. (Note: You cannot put folders of PDFs in the auto-import folder, only individual PDFs.) Click the OK button when you have finished selecting your options. (Note: A folder within the auto-import folder will be created to hold PDFs after they have been imported, so you can easily tell which files have already been imported and which have not yet been imported.)
EndNote will check the auto-import folder for new PDFs when a library is opened. After opening the library, EndNote will scan for new additions to the folder on a schedule. If you continue working in EndNote and adding PDFs to the auto-import folder, new PDFs added to the folder should be imported into EndNote within ten minutes of adding them to the folder, but you will need to be working in EndNote. If you have been working in another program and switch back to the EndNote window, but do not see your new additions, click on any reference in the list of references to trigger importing.

3.2.2 Macintosh

- Select Preferences from the EndNote X9 menu to open the EndNote preferences panel.

  1) Click the PDF Handling option in the preferences panel to see the window below. Here you can set automatic renaming options for PDFs you import or set a “watched” auto-import folder. Any PDF added to the auto-import folder will be imported into the EndNote library. 2) Click the Save button when you have finished selecting your options, then 3) close the window.
4 Importing Text Files

Although direct export is a very popular way of importing references from online databases, data can also be saved as a text file and then imported. Two advantages of saving a text file and then importing it are—

1. Duplicates can be filtered out during the import process, before they enter the library.

2. If the Find Full Text preferences are set to Automatically invoke Find Full Text on newly imported references, then EndNote will automatically start searching for PDFs to match all the imported references as soon as the import is finished.

Importing works by pattern matching, so it is very important that the pattern of the data saved matches the pattern of the EndNote filter used to import it. Check the EndNote filter’s About This Filter section for instructions for downloading data in the correct format to match the filter.

Below are instructions for saving text files from two popular databases, the Web of Science and PubMed.

4.1 Web of Science

4.1.1 Saving the Data from Web of Science

The method below uses the Web of Science Marked List and will allow you to import the PubMed PMID number into the Notes field of the EndNote record if you are searching the Web of Science Core Collection. The instructions are the same for both Windows and Macintosh.

- Perform your search in the Web of Science Core Collection.
• Mark the records you want to save and click the Add to Marked List button.

• After selecting all records, click the Marked List button.

• In the Marked List, select 1) All records in this list (up to 500), 2) the fields you want exported, and 3) the Save to Other File Formats option from the Select Destination drop-down list. Please note the PubMed ID field will only be available if you have limited your search to the Web of Science Core Collection.

• In the window below, select 1) Other Reference Software, then click the Send button.
• If you see a window asking if you want to save the file or open it, such as the example below, save the file. Make a note of the location the file is saved in, EndNote will not know the location. Note that files saved in this way from the Web of Science have the default name `savedrecs.txt`. This file can be emailed to another EndNote user as an attachment for import, if desired. It is just a plain text document.

4.1.2 Importing the Web of Science File on Windows

• To import the file into EndNote, in EndNote select 1) `File`, 2) `Import`, then 3) `File`.  

![Image of EndNote import process]
In the window below, 1) click the Choose button and select the savedrecs.txt file to open. You will need to know where you saved the file. Then 2) select Other Filters from the drop-down Import Option list. Note that after a filter has been used once, it will appear in the drop-down list in the future.

In the window below select 1) the Web of Science Core Collection filter, then 2) click the Choose button.

If you think you might import duplicates of some of the references in your library, 1) choose Discard Duplicates from the Duplicates drop-down list, then 2) click the Import button.

The references will be imported into EndNote and appear in the Imported References group.
The PMID will appear in the Notes field as a number.

4.1.3 Importing the Web of Science File on Macintosh

- To import the file into EndNote, in EndNote select 1) *File*, then 2) *Import*.

- In the window below, 1) select the folder the file was saved in, 2) select the downloaded file, and 3) click the *Options* button.

- In the options, select *Other Filters* from the *Import Options* drop-down list to bring up a list of import filters.
• In the window below select 1) the Web of Science Core Collection filter, then 2) click the Choose button.

• If you think you might import duplicates of some of the references in your library, 1) choose Discard Duplicates from the Duplicates drop-down list, then 2) click the Import button.
The references will be imported into EndNote and appear in the Import References group. The PMID will appear in the Notes field as a number.

4.2 PubMed

4.2.1 Saving the Data from PubMed

Direct export from PubMed will allow importing of up to 200 records at a time, while saving a text file from PubMed and then importing will allow you to import thousands of records at a time, if you wish to do so, and it will allow you to filter out duplicates during the import. The directions below use PubMed’s clipboard feature, but records can also be exported directly from the search results screen. Directions for saving data from PubMed are the same for Windows or Macintosh.

- Perform your search on PubMed’s web site.
- Mark the records you wish to import and 1) click the Send to: button, 2) choose Clipboard as the destination, and 3) click the Add to Clipboard button. This will add the selected references on the page to the clipboard. You can then go to the next page in PubMed and select more references.

- When finished selecting references, click the link showing the number of items in the Clipboard, to the right of the Send to: button. This will take you to the Clipboard.
In the Clipboard, 1) click the **Send to:** button, 2) select **File** under **Choose Destination**, 3) select **MEDLINE** as the **Format**, and 4) click the **Create File** button. Note that if you do not select the MEDLINE format, the file will not import into EndNote correctly.

If you see a window similar to the one below, save the file and make a note of where you saved it. The default file name for files saved from PubMed is **pubmed_result.txt**. This is a plain text file and can be emailed as an attachment.
4.2.2 Importing the PubMed file on Windows

- To import the file into EndNote, in EndNote select 1) *File*, 2) *Import*, then 3) *File*.

- In the window below, 1) click the *Choose* button and select the `pubmed_result.txt` file. You will need to know where you saved the file. Then 2) select *Other Filters* from the drop-down list. Note that after a filter has been used once, it will appear in the drop-down list in the future.
In the window below, 1) select the PubMed (NLM) filter, then 2) click the Choose button.

If you think you might import duplicates of some of the references in your library, 1) choose Discard Duplicates from the Duplicates drop-down list, then 2) click the Import button.

The references will be imported into EndNote and appear in the Imported References group. The PMID will appear in the Accession Number field.
4.2.3 Importing the PubMed File on Macintosh

- To import the file into EndNote, in EndNote select 1) File, then 2) Import.

- In the window below, 1) select the folder the file was saved in, 2) select the downloaded file, and 3) click the Options button.
- In the options, select Other Filters from the Import Options drop-down list to bring up a list of import filters.

- In the window below, 1) select the PubMed (NLM) filter, then 2) click the Choose button.

- If you think you might import duplicates of some of the references in your library, 1) choose Discard Duplicates from the Duplicates drop-down list, then 2) click the Import button.
• The references will be imported into EndNote and appear in the *Imported References* group. The PMID will appear in the Accession Number field as a number.

### 5.1.1 Back Up the EndNote Desktop Library

First, you should make a complete backup copy of your desktop library by saving a compressed library. Note that EndNote may ask if you want to make a backup when you begin syncing, but you can make a backup at any time using the method below.

- Select *Compressed Library* from the *File* menu in EndNote. You should see a screen like the one below. Leave the options as shown to save a complete copy of your library with all attachments.

![Compressed Library Screen](image)

- Click on the *Next* button to select a location to save the file. This will bring up a standard “save” dialog window.

- Select the location and click the *Save* button. It may take some time to compress and save a large library, so be patient.

- Note that although you *cannot* safely keep a working EndNote desktop library in cloud services such as Dropbox, you can keep a compressed library in the cloud for backup purposes. See section 7.5 for more information.
5 Cite While You Write

EndNote’s Cite While You Write (CWYW) lets you look up references, insert them in your document, format your bibliography, and edit your citations to include page numbers or other text, all from within your word-processing document. Below are instructions for using Cite While You Write with Microsoft Word.

6.1 Cite While You Write in Microsoft Word on Windows

6.1.1 Installing the Cite While You Write Tools

When you install EndNote, it will automatically install files into a common program folder, allowing EndNote and Word to communicate and enabling Cite While You Write (CWYW). In Word for Windows you will see a tab on the ribbon similar to that shown below. (Note: It is best to close all other programs before installing EndNote, most especially Word and Outlook. When installing Word and EndNote on a new computer, always install Word first to enable EndNote to find it and be able to install the Cite While You Write tools.)

Below is information on using the Cite While You Write tools you will need on a day-to-day basis.

6.1.2 Adding Citations to a Document Using Insert Citation

- Click in the top half of the Insert Citation button in Word to open the Find & Insert My References window.
In the Find & Insert My References window that appears, (1) select whether you want to search your open EndNote desktop libraries or groups shared with you in EndNote online, (2) enter your search terms, and (3) click the Find button, or press the Enter/Return key, to bring up a set of references that contain those search terms. The terms can be anywhere in the EndNote record, but all the terms must be present in the same record.

Next, select (highlight) the reference(s) you want to insert. When you select a single reference, you will see the details for that reference in the bottom part of the window, but details can be shown for only a single reference. However, you can select multiple references for insertion by holding down the Control key and clicking on them, then selecting your insertion options from the Insert list.

Your references will be inserted in the document and instantly formatted.

6.1.3 Adding Citations to a Document Using Insert Selected Citation(s)

To select the citations you will insert in the document, return to EndNote by clicking the Go to EndNote button.

In EndNote, select (highlight) the references you want to insert. You have two choices for how you
insert them in the document.

- You can insert them in the document from EndNote using the first button of the set shown below, *Insert Citation*. (Note this is a different command than the *Insert Citation* button within Word, being the equivalent of the *Insert Selected Citation(s)* command in Word.) This will insert the references wherever your cursor is located in Word.

- If you would like to check if your cursor is in the correct location and then insert the references from within Word, in EndNote click on the third button shown in the set below, *Go to Word Processor*.

- If you returned to Word to insert the selected citations, click the bottom part of the *Insert Citation* button, then select *Insert Selected Citation(s)* from the drop-down list.

- Your references will be inserted in the document and instantly formatted.

### 6.1.4 Selecting the EndNote Style for Your Citations and Bibliography

- You can select your preferred style from the drop-down style list as shown below, or select the *Select Another Style* option to see the list of EndNote styles available on your computer. (Note that a typical installation of EndNote only installs a list of popular styles. You can perform a custom installation of EndNote to install more styles or download them from the [EndNote web site](http://www.endnote.com). See section 1.2.1 for instructions for a custom installation of EndNote.)

- If you would like more control over the formatting of the citations and bibliography, such as the ability to change the line spacing or set hyperlinking options between the citations and bibliography, click the *small arrow in the bottom right corner of the Bibliography group* to open the *Configure Bibliography* window.
• The two tabs in the Configure Bibliography window provide options for changing the style, adding, removing, or formatting hyperlinks between citations and their matches in the bibliography, adding a centered title above the bibliography, changing the font used for the bibliography, and more. Select your options, then click the OK button to make your changes. Changing these options using Word commands would not create permanent changes; you must use the Configure Bibliography command to permanently change options such as font or line spacing in the bibliography.

6.1.5 Editing Citations in the Document

If you try to edit citations in a document by simply typing the page numbers into a citation or removing an author’s name from a citation, the change will only be temporary and will disappear with the next update of the bibliography. Worse than that, you risk corrupting the citation codes, which would prevent EndNote from updating them and could cause other problems in your document. The safe way to make changes to the citations is using the Edit & Manage Citation(s) command.

• Click on the citation you want to change, then click the Edit & Manage Citation(s) button.
• In the *Edit & Manage Citation(s)* window there are two tabs in the lower part of the window. The first tab, *Edit Citation* (shown below), contains fields where you can add prefix or suffix text to a citation, as well as page numbers for those styles that require them. There is also a drop-down *Formatting* list that provides options to put the author’s name before the citation, exclude an author’s name, exclude the year, or show the reference only in the bibliography. (Note: If you are using a style where page numbers entered in the *Pages* field do not show, enter page numbers in the *Suffix* field, which will always show.)

![Edit & Manage Citation(s) window](image)

• The second tab, *Reference*, shows the details for the selected (highlighted) reference in the top half of the window.

![Reference tab](image)
Along with being able to add text to citations, you can also use the Edit Reference drop-down list for each reference to add new citations to the grouped citation with the Insert Citation command, or safely remove citations from a grouped citation with the Remove Citation command. This is the safest way to remove citations from a document because it safely removes all the hidden coding. If the coding is not completely removed, it can result in a corrupted citation.

![Image of EndNote X9 Edit & Manage Citations]

6.2 Cite While You Write in Microsoft Word 2016 on Macintosh

6.2.1 Installing the Cite While You Write Tools

When you install EndNote X7.5 or later it will automatically install files allowing EndNote and Word 2016 to communicate and enabling Cite While You Write (CWYW). In Word 2016 you will see a tab on the ribbon, similar to that shown below.

![Image of Word 2016 ribbon with CWYW tab]

Below is information on using the Cite While You Write tools you will need on a day-to-day basis.

6.2.2 Adding Citations to a Document Using Insert Citation

- Click the Insert Citation button on the EndNote tab in Word to open the Find & Insert My References window.
• In the Find & Insert My References window that appears, (1) select whether you want to search your open EndNote desktop libraries or groups shared with you in EndNote online, (2) enter your search terms, and (3) press the Return key on your keyboard, to bring up a set of references that contain those search terms. The terms can be anywhere in the EndNote record, but all the terms must be present in the same record.

• Next, select (highlight) the reference(s) you want to insert. When you select a single reference, you will see the details for that reference in the bottom part of the window, but details can be shown for only a single reference. However, you can select multiple references for insertion by holding down the Command key and clicking on them, then selecting your insertion options from the Insert
list.

- Your references will be inserted in the document and instantly formatted.

### 6.2.3 Adding Citations to a Document Using Insert Selected Citation(s)

- To select the citations you will insert in the document, return to EndNote by clicking the *Go to EndNote* button.

  ![Go to EndNote](image)

- In EndNote, select (highlight) the references you want to insert. You have two choices for how you insert them in the document.
  - You can insert them in the document from EndNote using the first button of the set shown below, *Insert Citation*. (Note this is a different command than the *Insert Citation* button within Word, being the equivalent of the *Insert Selected Citation(s)* command in Word.) This will insert the references wherever your cursor is located in Word.

  ![Insert Citation](image)

  - If you would like to check if your cursor is in the correct location and then insert the references from within Word, in EndNote click on the third button shown in the set below, *Return to Word Processor*.

  ![Return to Word Processor](image)

  - If you returned to Word to insert the selected citations, click the down arrow on the *Insert Citation* button, then select *Insert Selected Citation(s)* from the drop-down list.

  ![Insert Selected Citation(s)](image)

- Your references will be inserted in the document and instantly formatted.

### 6.2.4 Selecting the EndNote Style for Your Citations and Bibliography

- You can select your preferred style from the drop-down style list as shown below, or select the *Select Another Style* option to see the list of EndNote styles available on your computer. (Note that a typical installation of EndNote only installs a list of popular styles. You can use the Customizer under the *EndNote* menu to install more styles or download them from the EndNote website.)

  ![Select Another Style](image)

- If you would like more control over the formatting of the citations and bibliography, such as the ability to change the line spacing or set hyperlinking options between the citations and bibliography, click the *Configure Bibliography* button to open the *Configure Bibliography* window.
The two tabs in the Configure Bibliography window provide options for changing the style, adding, removing, or formatting hyperlinks between citations and their matches in the bibliography, adding a centered title above the bibliography, changing the font used for the bibliography, and more. Select your options, then click the OK button to make your changes. Changing these options using Word commands would not cause permanent changes; you must use the Configure Bibliography command to permanently change options such as font or line spacing in the bibliography. (Note: it is best not to mark the box to Link in-text citations to references in the bibliography until you have finished editing the document. If you mark this box, whenever you try to select a citation, EndNote will jump to the bibliography.)

6.2.5 Editing Citations in the Document

If you try to edit citations in a document by simply typing the page numbers into a citation or removing an author’s name from a citation, the change will only be temporary and will disappear with the next update of the bibliography. Worse than that, you risk corrupting the citation codes, which would prevent EndNote from updating them and could cause other problems in your document. The safest way to make changes to the citations is using the Edit & Manage Citation(s) command.

Click on the citation you want to change, then click the Edit & Manage Citation(s) button.
In the Edit & Manage Citation(s) window there are two tabs in the lower part of the window. The first tab, Edit Citation (shown below), contains fields where you can add prefix or suffix text to a citation, as well as page numbers for those styles that require them. There is also a drop-down Format list that provides options to put the author’s name before the citation, exclude an author’s name, exclude the year, or show the reference only in the bibliography. (Note: If you are using a style where page numbers entered in the Pages field do not show, enter page numbers in the Suffix field, which will always show.)

The second tab, Reference, shows the details for the selected (highlighted) reference in the top half of the window.
Along with being able to add text, remove the author name, or remove the year, you can also use the drop-down list for each reference to add new citations to a grouped citation with the *Insert Citation* command, or safely remove citations from a grouped citation with the *Remove Citation* command. This is the safest way to remove citations from a document because it safely removes all the hidden coding. If the coding is not completely removed, it can result in a corrupted citation.